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O1V &5
Quick Start Guide

This is a “quick start guide” designed for people about to use Yamaha 01V96i for the first time. It is not
a guide to audio mixing and it assumes the reader has experience of analog mixers. It does not replace
the manual; we recommend referring to the manual if further information is required.

01V96i manual and then the editor and
Q drivers guides. Mmmmmmmm

there has got to be a quicker way....
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01V96i Quick Start Guide

Getting Started with a 'blank’ desk

To erase all memories in the desk, and return it to its factory settings, hold the SCENE MEMORY [STORE] switch
while turning on the power, and choose the INITIALIZE option. (You don’t need to do this if you have just unpacked the
product from its box for the first time)!

- SYAMANA © i

To start from blank settings without erasing the memories, just recall SCENE 00. To do this, use the SCENE MEMORY
Up-Arrow/Down-Arrow switches to select Scene ‘00’ and then press [RECALL].

SCENE MEMORY

All the faders will then move down and all the mixing functions set to their default status.

Understanding the Rear Panel and Top Connectors

All the analog input connectors are at the back of the top panel. The analog outputs and digital I/O are found on the rear
panel. They include:

Rear Panel

ADAT optical 8-channel Digital Input and Output
Monitor Out with Jacks, for connecting to (for multi-track recorder or computer sound card, for example).

powered monitor speakers (or an amp for

powering passive speakers) ' 2-Track Digital Out and In USB 2.0 port for multi-track live

recording with DAW software and

(for Mini-Disc/DAT, for example) .
Yamaha Studio Manager software.

4 'OMNI’ analog outputs
with Jacks

WORD CLOCK 04 TR T TO HOST

OMNI OUT

+4dB (8AL) (%]

IN

G

POWER

= ON
ML OFF

Main Stereo Output with XLRs 1 option slot for expansion

Other connectors on the rear panel are for various control and sync functions. For example, the WORD CLOCK con-
nectors are for synchronizing with other digital audio devices, the MIDI ports are for communicating with other musi-
cal instruments (such as keyboards).
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01V96i Quick Start Guide

Top Panel
INPUT A/B connectors accept mic/line inputs with XLR and balanced TRS 4 Line inputs with

phone jack respectively. If you plug cables to INPUT A and INPUT B of the balanced jacks
same number, only the signal from INPUT B is effective.

2TR
-10dBV (UneAL

O O

N — S - - A CHI5/16 A MONITOR
INSERT I/0  INSERT I/0  INSERT 1/0  INSERT 1/0 INSERT I/0  INSERT /0 INSERT I/0  INSERT I/0 - AL = A
15 SN
’ \
o LE\IEL‘(7
~ z ~ ~ - - . 7 - 7 MONITOR PHONES
i o, e o | : C Sl our
~|E, \~SO 16[ \'50 'lEI \'SO -161 \-60 -|S/ \-50 o e ~16' -80 -16' \'SO
EEGANEE EESGANEN EXNGANEN EXIGANEN || EXIGANEW EE ESGANEl  EXIGANEE

PEAK PEAK PEAK PEAK PEAK PEAK PEAK PEAK PEAK PEAK. 0 ‘ 7 7
SIGNAL SIGNAL SIGNAL SIGNAL SIGNAL SIGNAL SIGNAL SIGNAL = sianaL_*® _WJ__.WQQ

S Unbalanced insert jacks for the 12 4
. mic/line inputs .
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01V96i Quick Start Guide

Understanding the Front Panel

All the controls are on the front panel, laid out in logical areas:

Display Access switches Analog input gain and pad (+48V switches are on the rear panel,
(choose what to view on the LCD) and switch on phantom power for 4 channels at a time)

PHANTOM +48V

15

O 00
A A | (q(m
w® 0O e
7 g e Monitor and
o SV o T o el B Headphone controls
4 / g , 4 : g. 7 > PHONES
Bowilh dowilh Bowid Bowl Bonil Boni Boni Bonll Bl o Howil Howis W ® ol
DISPLAY ACCESS
HEE N
EEN
BT ndtila G : €
mﬂs E ! ; 5 ) Display control and Scene
= : Memory buttons

EQ and Pan controls for the
selected channels =

SOLO  SOLO  SOLO  SOLO  SOLO | SOLO  SOLO SO0 | SOLO SO0 | SO0 | SOLO | SO0 SO0

AT S A EEEEEEEEEERE®R
o ow ow  ow | ou o ow ow | ow ow  ow on | ov o Level pots, On, Solo, Sel for
1 2 3 4 5 6 7 8 9 10 1 12 13 14 15 16 3 the Stereo input channels

n 12 13 14 15
27 8 2 20 al
sus3 susa uss sus6 sus7

I Aux select and Fader Layer buttons Faders, On, Solo, Sel buttons User Defined Keys (for
for the channels short-cuts)

#% The SELECTED CHANNEL area is a fundamental concept to understand. It shows important functions for one
channel at a time. Only one channel can be selected at any time. To select a channel (and see its settings in the
SELECTED CHANNEL area), just press the [SEL] button. Then press the[ SEL] button for another channel when
you are ready to move on.
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Controlling Channel Faders

There are 4 layers of faders on the 01V96i:
When you change layers, all the channel settings are remembered. You just change which channels you are looking at!

Input channels 17-32 Master Layer: Aux 1-8, Bus 1-8

Remote Layer for controlling other

Input channels 1-16 functions / devices

17-32 MASTER REMOTE

Each fader controls a different input to the 01V96i. This assignment is not fixed: it can be changed in the PATCH
menu.
Here is the default patch:

15 channels 1-16 control the 16 analog inputs on the top on the console;

1= channels 17-24 control ADAT inputs 1-8;

1= channels 25-32 control inputs 1-8 from the Slot;

1 stereo channels 1-4 control inputs from internal Effects 1-4.
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Changing INPUT PATCH

To assign different inputs to the input channels, such as Slot 1 inputs 9-16, follow these steps:

1.

Press the [PATCH] DISPLAY
ACCESS key.

If necessary, press it repeatedly
until the IN PATCH page is dis-
played.

Press the [SEL] button for the
required channel (or move the cur-
sor on the screen to the required
channel number).

Press [ENTER] (by the data wheel
on the right side of the console).
This will open the PATCH SELECT
window.

Select the type of input from the
first list (AD in / Slot in / FX out
and so on).

Press [ENTER] and choose the
required item from the next col-

umn (CH# or FX unit for example).

PATCH kenl STI1 STI1Z §TI3 514
4 » cht i 10 ‘CD @ @ ]

Press [ENTER] and click YES on
the screen to complete the Patch
change.

'| DISPLAY ACCESS

SCENE DIO/SETUP  MIDI uTiuTy

PAIR/

#/INSERT/ _ PAN/ Al

DELAY ROUTING GROUP

DYNAMICS EQ EFFECT VIEW

PATCH Initial Dota  @FHTSIIZSTISSTIS
CH1-CH1 )
. INPUT PHTCH]

sl INPUT CH1 PATCH. USE IN 1

fll 2TR 1IN
FX ouT
sdl:USE 1N

Hl 5LOT 1IN
ADAT 1N

ERINEANN
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FADER MODE

There are nine FADER MODE keys to the left of the LCD.

FADER MODE
AUX 1 AUX 2 AUX 3 AUX 4

AUX 5 AUX 6 AUX 7 AUX 8

. : " = a";'n'ﬂ EEEEE = g

HOME (METER)

[HOME] is the normal mode for the faders. Pressing the [HOME] key will show various METER pages on the LCD, so
input, output, and Effect channels can be metered.

The AUX 1-8 keys select one of the Aux Send levels to be edited by the faders, instead of the normal channel level. You can
also see the Aux Send levels on the LCD, represented either by rotary pots or by bar-graphs. Pre and Post Fade settings can
only be edited on the LCD, by using the cursor keys and the [ENTER] key. By pressing the [ENTER] key while the cursor
is over an Aux Send rotary pot, the Aux Send will be switched Off/On.

Pressing [HOME] again will always return the faders to show the channel fader level.
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Using the SELECTED CHANNEL controls

When a channel is selected, some of its settings can be seen and controlled in the SELECTED CHANNEL area. The cur-
rently selected channel’s name and number is always shown in the top-left corner of the LCD screen.

4 SELECTED CHANNEL area

SELECTED CHANNEL

)  PAN

EQUALIZER

HIGH-MID

®

FREQUENCY

@

GAIN oW

4 EQUALIZER
When one of the EQ controls is moved, the LCD will show the EQ edit screen. There are 4 parametric bands. Select
which band to control with the HIGH, HIGH-MID, LOW-MID and LOW switches. Note that the LOW band can be a
Low Shelf or a HPF by changing the Q to the maximum or minimum position. In the same way, the HIGH band can
be a High Shelf or a LPE. There are 2 types of EQ (TYPE I or TYPE II), with slightly different sound characteristics.
The ATT function (seen in the LCD next to the EQ curve) is an attenuator, or digital trim, to adjust the channel level

pre-eq.

SELECTED CHANNEL EQ lnitial Data B STIT STIZSTIZ 5TT4
= _[:HI—[:H_|I 00 & (SIS HY)
.CH1 E@UAL | ZER EDIT:' CH1
CURVE

ATTT |F

TYFET
€] _ T i
a.0|f ing 10K 10K
» il ]
LOKW L-MID] H=-MID HIGH
Q =] [T=)] )] [al
. i ® L .SHELF @ 8.70 @ a.78 H.SHELF
. @ IF1 IF1 IF1 [F1
FREQUENGY. 125 Hz 1.88kHz 4.80kHz 18.8kHz
LOW-MID o [G] [G] [G] [G]
a.8d8| | » 8.8dE 0.8dB 8.8dE

@

GAIN

JLEG L IERAr s

Low
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4 PAN

The PAN settings of the selected input channel can be edited here (output channels do not have Pan). 01V96i can also
perform surround panning. To select a SURROUND MODE, press the [PAN/ROUTING] Display Access Key so the
SURR MODE page is shown on the LCD. Then choose the SURROUND MODE: 3-1 or 5.1 or 6.1. This will then con-

vert some of the buses (1-8) into Surround Buses, and more displays will be added to the PAN menu for editing the
Surround Panning parameters.

SELECTED CHANNEL PARSROUTE Inltlu] Dutu STIT STIZ ST 5114
~ | CHI-CH1 IOO W @ O
Pnr]

MODE =

o HIGH @ @
Q
» CENTER CENTER CENTER CENTER CENTER CENTER CENTER CENTER LE3  RE3
z1 2z 23 24
OOO0OO0OO0ODOO0O0O ©©®

CENTER CENTER CENTER CENTER CENTER CEMTER CEMTER CENTER LE3 RE3
FREOUENCV 25 26 27 28 29 Se 31 32 4L — 4R

(D(D(D(D(D(D(DCD(D@

CENTER EENTER CENTER EENTER

PFIHIFII]UTEI Inltlu] Dutu
CHi-CHIi 00

|STI1 STIZSTISSTT4
m| &) @

[SURFOUND_HODE) [FAnr=UEE Lite]
DISPLAY ACCESS SURROUND MODE STEREDI 3-1 I 6.1 I
S.1

=3
3 BUS1 BUSS BUSZ

DYNAMICS EQ EFFECT VIEW

BUS3 BUS4

SURR/BUS SETLIP #,
CH EDIT 3 SURRiI-16 &SURR1?—32§:§

In SURROUND MODE
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4 DYNAMICS

Each input channel has both a GATE and a COMP. The output channels only have a COMP. When the [DYNAMICS]
Display Access key is pressed, the LCD shows the relevant GATE or COMP screen. Gain Reduction meters and Key-In
source can also be viewed here. Usefully, the COMP can be positioned pre-eq, pre-fader (post-eq) or post-fader.

DISPLAY ACCESS

SCENE  DIO/SETUP

MIDI uTiLITY

EFFECT

#/INSERT/ _ PAN/
RO

ING
EQ
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DYHAMICS | Initial Dota TITEZ I F 514 D'l"IHHIESIOOInitiul Oata |3| TIT SITZ S1TE 5119
CHI—CHI | [EoiT] [ CHI-CH1 | 3]
CH1_GATE EOIT) CA___ CH1_COrE EDIT o
CLRVE TYPE CURYVE TPE
KEYIMN STERED POSITION STERED
SOURCE LIHE GRTE |EQSITION] LTHE
I [
T . L FRE — || ;
; oFF or FADER .
AL r r -
. FRERMETER . PARAMETER
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4 ROUTING

In the [PAN/ROUTING] menu, the Selected Channel can be routed to any of the 8 Buses, to the Stereo Bus and to a
Direct Output. Move the cursor to the required bus number ([1-8], [S] for Stereo and [D] for Direct output) and press
[ENTER] to route the channel. The PAN indicators below each channel number in the LCD ensure that the PAN of
the channels will follow through to the Buses. This is particularly useful when using the Buses as stereo sub-groups
(like on a typical analog console).

PAH/ROUTE] Imitial Dot @=L T STIZ=TIS3STT4
CHI-CHA |OO ‘ )
[ INPUT _CH1-16 ROUT MG CH1
1 z = 3 =] =] e =]
pent [ et e | o [ pit [ e e § ]
H B 3 HE EEHEEHE = = |E
EEsE e ElnE e ———
FEHEE]
Cursor Bl B Al Bl B Bl gl |l
» =] 1@ 11 z 15 13 15 16
[PAH B P I PA |
12 0@ 02 08 0E 08 02 0@
2@ DR B8 E3; 0E B8 Ba 2@
ENTER 52 2808 5E: 38 52 8888
EEHEE
HO B0 B0 50 50 B0 50

Buses can be routed to Stereo (just like Sub-Groups on an analog console). To do this, press the [PAN/ROUTING]
button to view the BUS TO ST screen. Here Buses 1-8 can be routed, panned and mixed to the Stereo Bus. Use the cur-
sor keys, data wheel and [ENTER] switch to adjust the parameters.

PAH/ROUTE] Initial Dato ‘ TITETIZTETI+ 5114

CHA—CHA | [EoiT] [ %)

[BLIS TO STEREQ D
DISPLAY ACCESS BUS1 BUSZE BUSS BLUSd BUSS BUSE BUST BUSS

PAMN PAN PAN PAMN PAMN PAM PAH PAH

BEEBEB DI |OOOIO OO

LB3 RG3 CEMTER | CEMTER | CEMTER | CEHTER | CEHTER | CEMTER

SCENE _ DIO/SETUP _ MIDI uTiuTy

] Ac]

JABUS TO ST & : §

Data wheel
Cursor
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4 O/ INSERT / DELAY

Press this DISPLAY ACCESS key to see Phase, Insert and delay information on the LCD. Phase reverse is only avail-
able for input channels. Insert and Delay are available for all channels except for the Stereo Inputs. Inserts need to be
patched, choosing which rear-panel connection (or internal Effect) to use for INSERT OUT and INSERT IN. The

INSERT POSITION can also be changed here.

DISPLAY ACCESS

DIO/SETUP  MIDI

uTiLITY

#/INSERT/ | _ PAN/
DELAY |ROUTING

g[clT STIZETIT 5TT4

)

s IHE. |]L"I'|OO Initial Dato
EDIT

CHi-CHL | [EDIT] k]
[[INSERT] CHI
.5"
POSITION
PRE PRE POST
M E& FADER +"H FADER FADER

COMP : COME_}- §

THEERT }rvi THEEET ot
TNSERT COHE
oHsoFF IR oMsoFF  [QEE]

auT QORDER

IHSERT

B hiviie B oOlviror BER

Press the [@/INSERT/DELAY] key again to see Delay settings for each channel. The maximum possible delay time
varies with sample rate. At 44.1KHz, the maximum possible delay time is 984.1ms. Input channels have an FB.GAIN
(Feedback Gain) and MIX parameter to create a simple delay effect. The DELAY SCALE can be changed to see the
delay time in equivalent distance, number of samples, beats-per-minute or number of Frames (linked to MIDI

Machine Control Frame Rate).

DISPLAY ACCESS

DIO/SETUP  MIDI

PAIR/
GROUP

uTiLITY

#/INSERT/ | _ PAN/
DELAY |ROUTING

kb4 THSFDLY] Initial Dato TITETIZTETI+ 5114
CHi-CHI IOOEEIII SIS
[THFUT CH1-16 DELAY] CHI

DELAY SCALE [meter][ feet | ERIM@E [ EEat |

1 z S 4 s 5 7 5
o |
[ msecl|954.1! @.0f e.ei @.8 @.80 @.6 ©.8] 0.0
LzanFiel | 43400 e @ @ @ @ @

MIX | +lee +1aa
FEGAM| @%@  ex ex ex 8%  e% 6%

] 1@ 1 1z 15 14 1=
[ msec] .0 @.8 @.@ Q.8 @.8; @.@ @.@
[zamFiel =] =] =] =] =] =] =]

MIX HEe: HEe: Hed: Hed: +Hoa: Hoa: +1oa
FE.GAIN 8% =k =k =E: 8% @k =k =E

FHASE Fy IMSERT g3 DLYi—1& ,ﬁ DLY1T—3Z & : §

After editing the delay time for one channel, double-click the [ENTER] key to copy this time to all the other channels.

13/32



01V96i Quick Start Guide

CHANNEL PAIR

If some Stereo input sources are used, such as a Synthesizer or CD player, it could be useful to pair the relevant input
channels together. There are two modes for pairing channels, as selected in the [PAIR/GROUP] menu.

HORIZONTAL
VERTICAL
PAIR/GRUP] Initial Data  E[EHLT $TLZ STLF 5114
gt 100 s L | O
DISPLAY ACCESS [THPUT PAIF] FAIR MODE IR
1 =434 : S¥PE ;. TEpS
D | EEm | EEE
skt ; 11z ISRPIE ;IS KPIE
» FoRoez] | (MoMoez] | (Wohosz] | (AEWO=E]
17Rp1E . 1a%pze ;. Z1IRpIZ ;. Z3RpE4
Aomorz] | (Aomoez] | (oMo | [(AOEeeg
ZSRPzE ; zFAPIE ; zORPSO ;| S kPEs

DYNAMICS EQ EFFECT

WoRoxz] | (Mohoiz] ; (ROWorz] | [mOmOeE)

IMPUT B OUTFUT _ J& M FACER JA M MUTE FE ey

Horizontal mode allows odd numbered channels to be paired with their adjacent even numbered channel.

Vertical mode allows channels on the top fader layer (1-16) to be paired with the equivalent channel on the layer below
(17-32).

Output Buses and Auxes can also be paired, but only Horizontally.

When channels are paired, they share the same fader level, the same ON, EQ, Gate, Comp, Aux settings. Pan and Routing
parameters remain separate (though Pans can be linked separately).

To quickly pair channels without using the LCD screen, first 1 hold down the
[SEL] button for the Left channel, then 2 also hold down the [SEL] button for H n

the Right channel (or vice versa) for half a second. This only works in Hori-
zontal Pair Mode.

SOLO SOLO SOLO SOLO

ON ON ON ON
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FADER GROUPS

Fader Groups are useful for controlling many faders by just moving one fader. There are 8 Fader Groups available for

input channels and 4 Fader Groups for output channels.

Here is how to link faders together in a Group:

1.

DISPLAY ACCESS

Access the [PAIR/GROUP]
displays on the LCD.

2,

#/INSERT/
DELAY

Choose a Group (A to H for
inputs, Q to T for outputs)
using the Cursor keys (right of

the console, by the data wheel).

ROUTIN

DYNAMICS EQ EFFECT

PHIH;E%UP'OOIMHG] Oato ESTH SHIZSTIZ 5174
_CH1-CHI | = 7 Raar]
FHFT—PADER GROUF]
3. Press the [SEL] buttons for the . CEM GROUP) ., Ol !MRUT|FRODER IASTER
. . EYYY Gab
required channels to include — EI
. [
them in the Group. t E
E . =
Fo
G . [
1P 1519 20 21 Z2 224
5 - o
= =
o . [
E - =
F . [ F I
G =
H . e e e e ["n 3
|HPUT @ OUTPUT a IN FADER & IN MUTE g: ;

Now, when one fader in the Group is moved, all the others move by the same amount. If one fader in the Group needs to
be moved by itself, then hold that channel’s [SEL] button while pushing the fader (but not while the GROUP menu is dis-

played, or else the channel will be removed from the Group).

NOTE: Channels cannot be in more than one Fader Group at the same time.
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MUTE GROUPS

Mute Groups are useful for switching On/Off many channels by just pressing one switch. There are 8 Mute Groups avail-
able for input channels and 4 Mute Groups for output channels. To assign channels to a Mute Group, follow the same 3
steps as made for a Fader Group, but while viewing the MUTE GROUP screens (Groups I to P are for Inputs, Groups U to
X are for Outputs).

Once a Mute Group is made, when the [ON] button for one channel is pressed, all the other channels in the same Group
are also switched On/Off.

PATR/GRUP| miiTal Tote  @ELT SHZ o= s
CHI-CH1 | [

L INPUT MUTE GROUF] O INFUT MUTE MASTER

da i iz dd dg Pl

[F d@@@ o

©

S
zI.'l
B
m]l

i
m|

i
m|

i
|

i
m|

i
m|

...... HMLUTE]

% 4 EHRELE

n
-
RS
ol

:

:

moIZIr®

=
T
&
5
m
n

moIZXZIrC X C—

HEHEEE EEE
== I==ENE ==
A e
m|{m{imimjimjgm|pmjjm

CHANNEL VIEW

The [VIEW] Display Access Menu provides some useful displays, showing all the important parameters for the selected
channel. The PARAMETER page shows EQ, Comp, Gate, Insert, Delay, Pair information, while the FADER page shows
Pan, Aux, Bus Routing, Group status. There is also a LIBRARY page where channel data can be stored and recalled.
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EFFECTS

There are 4 Multi-Effect Units inside 01V96i. They can be viewed on the LCD by pressing the [EFFECT] Display Access
key, and then pressing one of the buttons [F1]-[F4] below the LCD.

DISPLAY ACCESS

sceve oosEe Mo umumy @YAMAHA
SNSERT/ PAN( . PAIR/  PATCH
DYNAMICS
FADER MODE

AUXT  AUX2  AUX3  Aux4

AUX 5 AUX 6 AUXT7 AuX 8

i
VSJ
HOME (METER)

17-32  MASTER REMOTE

4 EDITING AN EFFECT

The Effect parameters can be edited using the data wheel and cursor keys to the right of the console.

To change the type of effect (from Reverb to Rev-X for example), follow the LIBRARY link shown on the left side of

the LCD to see the FX LIBRARY. Then scroll through the list with the data wheel, and press [ENTER] with the cursor
over the RECALL button on the left of the screen.

EFFECT Initial Data @EIIT SITZ STI3 1T+
cm—t:uﬁ 0 D O O O
EFFECT HAME METER: E
OUER
TYPE -0
REVERB HALL

DISPLAY ACCESS

EEEBN

SCENE DIO/SETUP MIDI uTiuTy

M= BHLANCE |

188%

——
2 REV TIME i IMI.OLY i HI .RATIO LO.RATIO
HE BB O JHE 1 © Mkl © L0 O
DIFF . DEMSITY E/R DLY i E/R BAL.
YRR RbOMNG—ZABL_, PATCH G s OO0 ©F 5 © 448
HPF {rLPF
! M Theu | O 2eknz
—— - @ GATE LVL G) ATTACK HOLD DECAY
DYNAMICS  EQ __ OFF @ 4m 325ms

7ams
1 EDIT # FxXZ EDIT f3 FX3 EDIT #4 FXd4 EDIT fE W[

EFFECT Initial Data FEIBIERIERIT
snn—sm! SIS YY),
EFFECT MNAME - METER: LIH_]
.
TYPE - 0

[In/zouT]
[EDIT_#) [PATCH )

TS Mc.  LIBRARY TITLE

55.Vintagse Phaser
RECALL 24.Max100 EFFECT TYPE
J] | 93.REY-K Plate

-6
-12
-1
=30

STORE| M 21.REV-A Hall [
SH.0renDbeck
cear] | 49.Eauali zer681
AT} FX1 LIB Fxz LIE FXs LIE Jh Fx4a LIE JE*[
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4 USING AN EFFECT

Before an effect can be used properly, it needs to be PRTCH QO lnitial Dota
patched. The default patch (factory setting) has Aux 1-4 CHo CHY =T

patched to the inputs of FX1-4 respectively. The stereo out-
puts of FX1-4 are patched to stereo input channels 1-4
respectively. This is convenient, but can be changed if nec-
essary. For example, an effect could be inserted in just one
channel using the INSERT OUT and IN patch. To change
the FX patching, go to the EFFECT page in the [PATCH]

display menu. g COMPZ765 R joUTZ
- |ouTi
“ EFFECTA®) “[ -
R OPENDECK R QUTZ

STI1 STIZ2 STI3 ST14

[EDIT] ik
.EFFECT INPUT/OUTPUT PATCH. IThsert |n-CHS
ouTi

“ EFFECTI @) -
g REU-X HALL p|OUTZ .

ouTi
L EFFECTZ & [

g REU-X ROOM  p|OUTZ

L EFFECT3 @

TH PATCH J& THPUT 1M J4  EFFEcT  JCASCADE THELRT

4 ROUTING AUDIO THROUGH AN EFFECT

1.

First, audio needs to be routed into the effect. If the default patch is used, first turn up Aux 1 send level for the
required channel: Select Aux1 fader mode, and push up the fader to the required level.

2,

Check that the Aux 1 Master fader is up to 0dB (that is its default position): select Master Layer and adjust the
Auxl fader position if necessary.

Already audio should be seen on the level meters of Effect 1. You can see the meters on the top-right corner of
the FX EDIT screen.

Then turn up ST IN 1 to start hearing the effect’s output in the Stereo bus: select the top layer for the ST IN
channels, and turn up ST IN1 encoder. The level can be viewed in the top-right corner of the LCD.

FADER MODE

AUX 2 AUX 3 AUX 4

SEL SEL
AUX 5 AUX 6 AUX 7 AUX 8

HOME (METER)

SOLOo SOLO

ON ON

ST IN 1/E] ST IN 2/8

EFFECT |00 Initial Dutu @ISTL1 ST1Z STI3 ST14
ISTIR-STI]} JECIT] i EE
EF

ECT_NAHME METER: III

=X _Hall ~OUER
TYFE u

REU—_HALL

LIERARY #) [_PATCH %,

&

(DF!EU TIME @INI I:IL‘r' GHI FIFITBID GLO RFITICI

G:] Dl FF (D ROOMS | ZE G DECFW LO. FREIS!
808 Hz

f

HPF
Thru O 3 2BkHz

Fx1 FDIT B FxX2 FOIT £ FXS FOIT g
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SCENE MEMORY

There are 99 SCENE MEMORIES available in 01V96i. Each Scene stores all the mixing
parameters, including all input channel, output channel and Effects parameter data.
The SCENE MEMORY list can be seen by pressing the [SCENE] Display Access key.

Ifa SCENE is PROTECTED,
it cannot be overwritten
when [STORE] is pressed.
This avoids erasing some-
thing by mistake.

DISPLAY ACCESS

EFFECT

4 RECALL SAFE

In this screen, choose which parameters will not be changed
when recalling a Scene. When the Global Recall Safe box is
checked (at the top of the screen), the chosen parameters will

be safe in all Scenes. Otherwise, these settings will only apply

to the current Scene (once it is stored).

4 SCENE FADE

Normally when a Scene is recalled, the Faders move instantly

to their stored position. Using the Fade Time function, the

faders can be programmed to move slowly, taking up to 30
seconds to complete their movement. Checking the Global
Fade Time box will give the same Fade Time to every Scene.
After setting the Fade Time for one channel, double-click the
[ENTER] button to copy the time to all Input or Output

Channels.

19/32

The PATCH LINK feature
can be useful if different
Scenes need different Patch
settings. Patch information is
not stored in the scenes, but is
stored in the INPUT PATCH
and OUTPUT PATCH librar-
ies (accessed from the
[PATCH] Display Access
key). Then the Patch libraries
can be linked to the Scenes so
they are recalled at the same
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8. Ho Datal ]
7.0 Ho Oatal 1
STORE 6.[ Ho Datal 1
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BCL SHFE

i
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4 SCENE COPY / PASTE

If some settings need to be copied from one Scene to some others, the PATSE SRC and PASTE DST LCD screens can
be used.

In the PASTE SRC screen, choose which parameters of which

. SCEHE 01 scene | &[T SITZSIIF 5174
channels should be copied. 4‘“1_3“1 W O O O
[BLOBAL FRSTE SOURCE CH SELECT)
|§EEEE%| SOURCE CHAMMEL
I MPUT: H!!IEIEHH
m n E E . E E . . = GROUFP MASTER=—
(=] el (1] [32] (53] (3] [35] [ie]
mEEEEEEE
@ N. IE' . . @ OTHERS
. —
—ig S
o
— (i =] [&]
AL
Kl = [E]
—STERED=
A PASTE SRC B

In the PASTE DST screen, choose which Scene Memories

: . SCEHE 1 P
should be updated. The maximum number is 10 Scenes for CH1-CHI 0 o
. [GLOBAL PRSTE DESTIHAT IOH SCERE]
each operation. o TITLE
4.1 Ho Datal ]
13,1 Ho Datal ]
12,1 Ho Datal ]
1. Ho DOatal ]
18.[ Mo Datal ]
9.0 Mo Datal ]
. . 8.0 Ho Datal ]
bl 7.0 Ho Datal ]
B.[ Ho DOatal ]
g.0 Ho Oata! ]
4. [ flo Datal 1
FROM
Fa® =orT B FASTE Shc By PASTE OST

To move a Scene to a different position in the Library, use the

. SCENE pE— TTT =TT STIZ 5119
SORT screen in the [SCENE] menu: CH1-CHI 0 1 | 0 @ O
SOURCE DEST IMAT | Oh
8. Mo Datal ] 1 Mo Datal ]
7.L Mo Dotal ] 1 Mo Datal ]
B.L Ho Daotal ] 1 Ho Datal ]
a.L Ho Datal 1 Ho Datal 1
4. Mo Datal 1 Ma ]
J.s5cene 3 1
Z.5cEne 2
1.s5cene | | 1
3 No Datal 1
4 Mo Datal 1
3.scene 3
2.s5cene 2
1.5cene |
A.Initial Data
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MONITOR

In this section of the console, the operator chooses what to listen to, and controls the listening level.

1.

The MONITOR OUT LEVEL adjusts the main lis-
tening level.

The [MONITOR/2TR IN] button selects what to lis-
ten to in the monitors, (and in the headphones).

The SOLO [CLEAR] button will turn off SOLO for
all channels.

When monitoring through headphones, adjust the
monitor level using the PHONES LEVEL. The sig-
nals output from the MONITOR OUT connectors
are also output from the PHONES jack.

© ©

O O-

2TR
-10dBV (UNBAL)

2 ' A MONITOR
= 2TR IN

./
~

3
2N
] : Olevel

MONITOR

PHONES
ouT

DIGITAL MIXING CONSOLE

Extra MONITOR functions are found in the [DIO/SETUP] menu, on the MONITOR screen. Different SOLO modes can
be chosen, the listening points can be changed (Pre/Post Fader), and the monitor can be switched to MONO:

DIOZSETUPI() { =cene |
CHI-CHI

/[FITSTIZSTIZ STT4

SIS S HS)
TTON | TOR .
I T FiODE CistEn
x SoLo.
:
e
[SOLO_TRIM]
30L0 TRIMl | M FADER/SOLO RELEASE S
[RFTER PAN]
aas (3
S0L0 SAFE CHANNEL
INPUT CH
ST IN FION 1 TR TR FIONG
LR R BLY: gas (3
MIDI /HOST MONITOR B BEMOTE fAa MACHINE g2
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Live Recording and Playback with Cubase Al

The 01V96i features USB 2.0 connectivity that allows you to multi-track record 16 in/16 out, with audio streaming at
96kHz/24bit, using Steinberg's Cubase Al bundled DAW software. This chapter will show the simplest method to create

your audio production with the 01V96i and a computer.

o
o

USB 2.0

96kHz/24 Bit

4 Equipment List
® Yamaha 01V96i Digital Mixing Console
® PC or Mac that is compatible with USB 2.0

@ Steinberg Cubase Al software
(Bundled with the 01V96i)

@ USB cable

4 Computer Requirements
For the latest information of Cubase Al, check the following web site: http://www.steinberg.net/

", Mac OS X 4" Windows
OS: Mac OS X 10.6 ~ 10.8* (32/64bit) . .
*Supported with Cubase Al V6.0.7 or above OS: Windows 7 (32/64bit)
CPU: Intel dual core CPU CPU: Intel / AMD dual core CPU
Core Audio ASIO, WDM

RAM: 2GB or above
HDD: 4GB of free space or above
Display: 1280 x 800 or above recommended - Full color -
DVD-ROM Drive
Internet connection for license activation

Tips: For the Hard Disk Drive, It is strongly recommended to use one with a speed of 7200rpm or faster for recording and
playback.

With regard to disk storage, allow 500MB per hour for each mono track at an audio quality of 48 kHz 24-bit. Or 1GB per
hour at 96 kHz 24-bit. So for example, 32GB will be able to record 16 tracks at 96 kHz for 2 hours.
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4 Recording Methods: To mix or not to mix

There are two methods of recording by routing input channels to DAW software - with or without mixing. You may use
either one or both of the methods according to the number of audio sources.

Direct Out Recording

When recording input signals as they are without mixing, you
can use Direct Out signals.

Prepare tracks on Cubase according to the number of mics and
audio sources, and record the signals without mixing. The level
balance and tone for each input signal are not adjusted during
recording, but can be adjusted later at mixdown - to mix multi-
track recordings into stereo.

Bus Out Recording

When recording more than 16 audio sources such as multiple
mic inputs and various musical instruments, you can record via
Bus Outs on the 01V96i. A Bus is the signal path that mixes
multiple input signals. The 01V96i is equipped with 8 BUS
(Group buses), 8 AUX buses, and a STEREO (L/R) bus.

4 Wordclock

Input

USB OUT
Connector
INPUT
connector 1 o
© M nput | .
INPUT Channels 1
connector 2 2
©) M nput | :
INPUT Channels 2 >
connector 3
© [ nput ] CH3
INPUT Channels 3
connector 4 |—| Ha
Input N
INPUT @ Channels 4 >
connector 5 s
[ input | !
@ Channels 4 >
o Input .
. Patch :
L]
Fig. Each Input channel routes directly to USB OUT
USB OUT
Connector
INPUT
connector 1 - H1
Input
INPUT @ Channels 1
connector 2
CH 2
Input
INPUT @ Channels 2 [1>] BusOut2 |
connector 3
Input
INPUT © Channels 3
connector 4
Input
INPUT @ Channels 4 Bus Out 4
connector 5
Input
Channels 4 Bus Out 5
L]
L]
L]

G

Patch

Fig. Input channels route to Bus Outs, Bus Outs route to USB OUT.

Wordclock is the signal that synchronizes digital audio equipment from one device to another. The 01V96i supports
recording up to 96kHz/24bit with 16 channels. If you need to change the wordclock source on the 01V96i, press [DIO/
SETUP] button to access Wordclock page and assign (INT48k as default).

DISPLAY ACCESS

MIDI uTiuTy

R/

PAI
GROUP PATCH

EFFECT VIEW

#/INSERT/ _ PAN/
DELAY  ROUTING

DYNAMICS EQ

@|STI1 ST12 STI3 ST14
© W ©

D10/SETUP) Initial Data
cms—cma“OO )

[WORD CLOCK SELECT!]

58T | v [out| /2 [ 304 |50 | 78 [ane 112123 11a)is /18
sLoT
P HO CARDAY a a
[adall IR I XIX[IX|X
3] Dx<Tue ] DX zro ] [ Tuse]
dakHz| | IINT44.1k|INT48k“ [intaa.2k] [ [inToek]
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4 Software setup

The follwoing applications are necessary to be installed in the computer:

® Download and install Yamaha Steinberg USB Driver from Yamaha’s proaudio website.

5 ( http://www.yamahaproaudio.com/global/en/downloads/firmware_software/ )

@ Install bundled Cubase AI and update it to the latest version.

1 For details on installation, refer to the installation guide on Steinberg’s website.
( http://www.steinberg.net/en/landing pages/cai6_activation_registration.html )

4 Recording

1.

Connect the console and computer by inserting the USB cable into the USB 2.0 port on the

rear panel.

Make audio patching for Direct Out or Bus Out:

Direct Out recording:

When recording signals sent from DIRECT OUT,
assign each DIRECT OUT to USB. Select the
channel for recording, and press the [View] Dis-
play Access key to access the FADER page. Then
assign USB 1-16 to each DIRECT OUT port
respectively in the BUS ROUTING section and
activate “D (DIRECT OUT)”. Repeat these steps
for all input channels.

DISPLAY ACCESS

SCENE DIO/SETUP  MIDI

uTiuTy

#/INSERT/ _PAN/  PAIR/
DELAY = ROUTING GROUP —-ATCH

VIER Initial Data  @[SLLT ST1ZSTI3 ST14
cm—cm‘lo L O © O
OUE|
PAN BUS AUX [ S
ROUT ING 2 3

CENTER

4
o )
= alo “
EE Fis
71131 s & 7 3
B0 | O @ Q[
00 -0 -oo -oo | FHEER
FOLLOW S MUTE
PAN =
 oni | Eq
=
coMP
=

o]

PRARAMETER £}

Bus Out recording:

When recording output signals from BUS 1-8 on the
01V96i, route the input channels to the correspond-
ing Bus for recording. (As an example here, using
BUS 1 & 2 for stereo mix recording) Select the chan-
nel for recording, and press the [View] Display
Access key to access the FADER page. Then select
BUS 1 &2 in the BUS ROUTING section. To activate
Pan to the buses, switch ON the FOLLOW PAN
option. Repeat these steps for all input channels.

DISPLAY ACCESS

SCENE DIO/SETUP  MIDI uTiuTy

#/INSERT/ _ PAN/ PAIR/
DELA PATCH

Y ROUTING GROUP

DYNAMICS EQ

02 ™

PAN

al ]

L IERARY 1-16 AUX giw]
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Note: For Direct Out recording, you may also choose the posi-
tion from which the audio signals are sent, e.¢ PRE EQ (record-
ing is unaffected by EQ, Dynamics and fader adjustments) or
POST FADER (EQ, Dynamics and fader edits affect the record-
ing). To change the setting, press the PATCH key to access the
DIRECT OUT page.

Note: For Bus Out recording, confirm that the Buses required
for recording are patched to USB OUT. Press the PATCH key to
access the USB OUT page and confirm if USBI set to BUSI,
USB?2 set to BUS2 respectively.

PATCH |02[ No Datal 1 [ST SIIZSII3 5114

CHi-CH1 |

[DIRECT OUT DESTINATION] [CH2T |
[o Assisn 4

PATCH Initial Data mSTH STI2 STI3 STI14
cuz—cu2‘|0 O OO

Activate the audio signals from the mics or audio sources. Press the HOME(METER) key to open the Meter

page and check the level meter for each input channel (and Bus Outs in case of Bus Out recording). Adjust the
gain to avoid clipping, and set the fader to nominal (0dB) level.

& 2 to check the level balance between them.

For Bus Out recording, press the MASTER key to show the MASTER Layer and press the SOLO key of BUS 1

Startup Cubase Al open Device Setup in the Devices
menu and set the driver to Yamaha Steinberg USB
ASIO (Yamaha 01V96i) in the VST Audio System sec-
tion.

)

Device Setup

[+ = u|

Devices

VST Audia Suctam

(& miot
© MIDI Port Setup
{3 Transport
Record Time Max
(3 video
1 Video Player
2 VST Audio Systen]
Yamaha 01V96i
Studio Manager
VST System Link

[ |

M Release Driver when Application is in Background

Input Latency: 3812ms
4.167ms
96.000 kHz

off

Output Latency:
HW Sample Rate:
HW Pull Up/Down.

Set 10 Defaults

Multi Processing
XTI - o prioad
Adjust for Record Latency

XTI - ecoré s

Audio Priority

Help ) Reset

o)
Cancel

(S

Open VST Connections in the Device

VST Connections - Inputs

menu, and add the necessary number of
recording buses (Mono or Stereo) for

B2A1 Add Bus

Bus Name TSpeaxers

Inputs | Outputs

presets IS

T Audio Device | Device Port

I

recording.

B3|
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If the Record Format | Cubase Al 6 Project - Untitled
(44.1kHz - 16 bit by ‘ : ‘
default) is different to
the 01V96i, it will be
highlighted. Click on it
to change the Record
Format, making sure
the sample rate
matches that of the 01V96i.

Open the Project menu and click Add track to add audio (Mono or Stereo) tracks.

SeleCt the input Ports fOr eaCh Cubase Al 6 Project - Untitled1
track 7 O £Y REEERENEE SRy = £ 00

(Tip: To assign all input ports at
one time, you can highlight all 5 Bosma
tracks and press Shift+mouse - e

. (o)) (R uw]
click). b DI Audoos

OO0 B3I
IR Audio 05
00 M
T R Audio 06
Tnserts 00 mm
Equalizers < R Audio 07
= (O R u]

BT Audio 08
(Channel B () R[u]

[Sends

(Wotepad™— ~ L 5. L1 1.1.1. 0

- D .

10.

Turn on the “Enable Rec” icon
on each track for recording. You
may also turn on the monitor

[ Audia 01 e

icon on each track to check the COoG =
o

level meter of each track.

(nserts
Equalizers
[Sends

(Channel

[Notepad

RAUTOD oFF

11.

Click “Rec” to start recording. 8no G

Mast

(nserts
(Eaualizers
[Sends

! Channe!

[Notepad 2

. | AlTOE oFF
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4 Playback

After recording, you can playback to check the audio. Follow the instructions below to check the 2-channel stereo mix on
the 01V96i.

] .  Toplayback through the 01V96i, you need to patch input i STI1 ST12 STI3 ST14
pay 8 Y paien b o100 "t M 0 O O @
channels to USB on the IN PATCH page. If you assign I =

USB 1-2 to the input channels 17-18, then you do not Lee iz 4

need to re-assign the patch again for recording. (Input
channels 17-18 are patched from ADAT by default)

r— S TEREQ | NPUT se——
iL— 1R 2L — . 3L — 3R 4L — 4R

ERT T ERT B EY ST HEY S S YT HEY S-S

2. Open VST Connections in the Device 8.0.0 S G
menu, and confirm if the Output bus -
(Stereo Out) is added. Also, make sure — i = u ] -
the device ports are assigned to ’ %;;: i Susels I

01V96i 1 and 01V96i 2 respectively.
(If the bus is not added, add the out-
put bus (Stereo) in a similar way to T B
recording.)

3. Also, make sure the output port on 3 4
each track is assigned to Stereo Out.

anNon ¢ Cubase Al 6 Project - testing.cpr

4. click “Play” to start playback.

I 1 v 1
17 25 33 a1 49 5

1 ) 3 73
ZANT~ e 7ANT

(=7 [m['s]agMico3 Mic0303 E——— 7 L AaMicos.

1 O
SR [ i, 1000 b O a1
| 2l[m] 4 g Line.04_0

(Chiaki3iContact 11,03

Y s Tl

biakl v 06.03

fobusMconuactiz.0a)

Tohru3157 0703 . Tohru3i7 07.05

4 DAW Remote Control D10/ SETUP iti STIT ST1Z 5113 5114
Initial Dat
y , et 10 . @ @ @
The 01V96i’s Remote function enables you to control external (D e ]
DAW, such as Cubase. For the information on how to setup the [COUNTER]
O TIME CODE an
1v96i 1 , pl fe P.83 of the 01V96i ref- g B |
01v96i to control Cubase, please refer to P.83 of the 01V96i re OFEET Qo200 169
erence manual. TNSERT ASSIGH/EDIT
AEEFEE
Rev 13 Page:81/81 :
IFX 1 Ho Effect
[ =Y O o [ = a o
ENTER ENTER ENTER ENTER

27/32



01V96i Quick Start Guide

01V96i Editor

01V96i gives you complete control of all the console’s parameters via your computer. To use 01V96i Editor, you need to

install:

« Studio Manager V2 Host

« 01V96i Editor

« Yamaha Steinberg USB driver

which are available to download on Yamaha proaudio website.

Setup:

To control your 01V96i with the Editor, you need to assign the input and output ports on both Studio Manager V2 Host

and 01V96i Editor.

ager port to USB.

1. Pressthe [DIO/SETUP] Display Access key on the 01V96i
to open the MIDI/HOST page, then patch the Studio Man-

DI0/SETUP
CH4-CH4

STI1 STIZ ST ST4
L @

@

[MIDIATO HOST SETUP]

GEMERAL SPECIAL _FUNCT | ONS
Fx PORT StudioManage
Tx PORT DAL
FREMOTE Cubase
‘ CASCADE LIMK |72
LE
TYPE Dl

REGUEST

MM

1D

Workspace.

2.  When starting up Studio Managar V2 Host for the first
time, choose File>Setup on menu to add 01V96i to

& Setup for Untitled 1 | ™= =x=)
Modify Workspace MIDI Settings Preferences
Add Device
maae Editor Workspace

01V961 ‘ﬂl\l?ﬁl
[ Add->
[ Remove

7] Set Default
Help Gencel | [ fon

Input and Output.

3. Open the MIDI Settings page to assign the ports on both

& Setup for Untitled 1 i

| Bea )

Modify Workspace | MIDI Settings | Freferences.
MIDI Ports

Tnput Ports
B Vamae VAT 1061
© Yamaha 0119612
© Yamsha 01v961-3
& Yamsha 01V96i-4
‘Yamaha 01V96i-5
Yamaha 01V96i-6
Yamaha 01V96i-7
Yamaha 01V96i-8

MIDI Thru

I Help

Output Ports
) Miooofi S icaiihie Synth

Yamaha 01v96i-1 [0fv96i)
& Yamaha 011962
Yamahs 01V96i-3
Yamaha 01V96i-4
Yamaha 01V96i-5
[ Yamaha 01V96i-6
Yamaha 01V96i-7
[ Yamaha 01V96i-8

[Update Ports

7] Set Default

CEIe= ][ &
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4, Open 01V96i Editor, choose File>System Setup on (& system setun =)
menu, assign the Input and Output Port. gt ort Yanaha 01V06i- B
Outut or
Console Device ID
@1 2 3 4 5 6 7 8
Channel Select Confirmation
[¥] PG -> Console V| Store Confirmation
] Gonsole > PG [7] Recall Gonfirmation
| Patch Confirmation
Layer Select
[¥] PG -> Console Window Control From Console
[¥] Console -> PC V| Enable
Level Meter
V| Enable
o ) e
o . - .
5. Synchronization between the console and the Editor. & 01v96i - Synchronization -
Direction

@ Console -> PG () PG -> Console

[ OK ] [ Cancel

Convenient save and load data

All of your console’s mix setting can be saved and loaded in your computer and synchronize between
the 01V96i. In case of using a rental or another installed console, you can easily save your settings to
a computer and load them into the other console at your convenience. The data files saved by 01V96i

il
.IE"-

ZTUDI
Ll

=
&
=E

Editor have a filename extension of “YSE”.
01VO6i.YSE
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01V96i Tips & Short-Cuts

Using the [SEL] switches

1.

CHANNEL PAIR

Hold [SEL] for one channel and press [SEL] for the adjacent channel to make a stereo pair. This works for input and
output channels, so long as the left side is an odd number and the right side is an even number. The channel with the
[SEL] button you hold first is the master channel for the pair: its settings are copied to the other channel (except for
pan and bus routing). Repeating this action breaks the stereo pair, to make the channels mono again.

CHANNEL COPY
Select the source channel with its [SEL] button, then press ﬂﬂﬁﬁﬂiglo 1 - ] ‘ & (TZI) 151 D
the [CHANNEL COPY] button (this must be assigned to ':HEEEHT :ESZI
a USER DEFINED KEY). Then press the [SEL] button of et 10/Channe!
the destination channel and click [PASTE] (also assign- [O crannet 10
able to a USER DEFINED KEY). |Ch_E1 honce] shor s hone
[FhoEr ] [od ] [PeH ] [Suee ]

NOTE: The parameters which are copied are deter- — D"' —

mined on the PREFER 2 page in the [DIO/SETUP] pisplas Brishiness 5‘35

menu.

FORMAT % FREFERT Jy FPREFERE JE v )

Other Short-Cuts

1.

EQ Gain to 0dB

To reset the gain of an EQ band to 0dB, press and hold the relevant band selection button (in the SELECTED CHAN-
NEL) for one second.

2. EQ Reset

To return the whole Parametric EQ for a channel to its default settings, press the [LOW] and [HIGH] band selection
buttons at the same time.

3. Copy STEREO Mix to an AUX

Press and hold LAYER button [1-16] or [17-32], then press a FADER MODE button [AUX1]-[AUX8], and click YES
in the confirmation box on the LCD. This copies the fader levels to the selected AUX sends. (Make sure the Aux sends
are all PRE by clicking the GLOBAL PRE button on the SEND page in the AUX DISPLAY menu).

NOTE: Repeat the same procedure for each fader layer to copy the whole mix to the Aux sends, as only one layer is cop-
ied at a time.

TIP: This is useful for making a quick headphone mix in a recording session, or making a quick stage-monitor mix for a
guest musician at a live performance.

SCENE FADE TIME Copy

To assign the same fade time to all channels, first enter the required FADE TIME for one channel, then double-click
[ENTER] to copy the time to all the other input or output channels.

DELAY TIME Copy

To assign the same delay time to all channels, first enter the required DELAY TIME for one channel, then double-click
[ENTER] to copy the time to all the other input or output channels.
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Other Tips
1. Fader Groups

To have DCA (or analog VCA) style Fader Masters, first check the INPUT FADER MASTER box near the top of the
IN FADER GROUP display page. Then select the [REMOTE] FADER LAYER, and assign USER ASSIGNABLE
LAYER as the TARGET. After that, all the GROUP MASTER FADERS can be selected to appear on the REMOTE
FADER LAYER, along with any other channels chosen by the user.

n|n;|}nup01 —cere 1 RET Sz SI[F5IIe
T2L-ST12
IHPUT_FAOER_GROUF] ]| HFUT FRDER: MASTER:
12 3 4 EE T E i1z 1314 T
BO@ @B @ o o e e o o e o
e RRRE

I I

=
3
m
fad
m

T3 HZIZM EXRITE DZ@WAIE F 4 E

IoTMmMmoomD I oTMmoom

i
H
i
H
i
¢
i
H
i
H
L

IMPUT _ #\ OUTPUT f3 IM FRODER ﬁ IH TE &:;

=|
|

2. MUTE MASTER Switches

nll]ISETupo.I pE— AT Sz SIS SII3
CHi-CH1 EDIT
{FEMTE] TBRGET] EEF AEE TGHRELE LAVER,
CLEAR
a (4]

OUER

)
- g
=12
-1
=30
-4

00 00 OO OO 00 00 OO

123456'1’

oo

=] ‘IB i@ 1|1 12 1|3 14 1|5 15

00 00 00 0o

FAFR MO0 /A0ST Fh MOMITOR Jy  REMOTE

ﬁ MACH | HE &:;

The USER DEFINED KEYS can be programmed to control the MUTE GROUP MASTER buttons. But first the
INPUT MUTE MASTER and OUTPUT MUTE MASTER boxes must be checked in the MUTE GROUP display
menu. Then the Mute Groups will behave in a similar way to those on a typical analog console: each channel’s [ON]
button is independent, while the Mute Master buttons will mute all the assigned channels, causing their [ON] buttons

to flash.

" IHFUT HMUTE GROUP
iz34 E& 7 &

FEPE -
T L L L

ERLE L 3

TPIE1930 NI EITE

ToZ=ZIrXTC—- TWOZZIDXEXL—

3. SCENE MEMORY Auto Update

UTILITY | scene |
[ CH1-CHI 01
[ISER _DEF INED EEY ASCIGH:

TITLE {fute Hasiers 7

EGENES B
- | & [E] =] (B] [E] ] (=] e

iln Mute Master K

ilh Mute Master O

@~ @ @ O-

@.0\'- (o) Qo+ [oes

In the PREFERI page of the [DIO/SETUP] menu, the ‘Scene MEM Auto Update’ option can be found. When this is
switched on, the last mixing settings are memorized just before the next Scene is recalled.
Then when a previous Scene is recalled, its last settings are recalled first. Press RECALL again to access the original
scene settings. So two memories for each scene are kept: the original settings, and the last settings.
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4. Return to Current Scene
When scrolling through the SCENE MEMORY list, it is possible to forget which is the current Scene. To force the dis-
play to show the current Scene number again, press both SCENE UP and DOWN buttons simultaneously.

5. USER DEFINED KEYS
Here are some suggested uses for these keys, apart from the defaults:
Scene +1/-1 Recall: to recall the next or the previous Scene.
OSC On/Off: to control the internal Oscillator.
Studio Manager: open and close various windows in the 01V96i Editor software on PC or Mac.
Display Forward/Back: to scroll through previously viewed displays.

6. Initialize Memories

To erase all the memories in the console and return it to is initial settings, first switch off the console. Then switch it on
again while holding the SCENE [STORE] switch. Choose INITIALIZE to erase all the libraries and return to the
default settings.

Check for the latest downloads at
www.yamahaproaudio.com
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